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Before You Begin
Before installing or using your DX8000 Series digital video recorder (DVR), complete and save the information on this page.

Installing the DX8100 DVR on a network will require support from your network administrator. The minimum network requirements for DX8100 
Series DVRs include a switched Ethernet LAN with a bandwidth of 100 Mbps. Contact your administrator to assist you in configuring the network 
features of the unit. 

Obtain and write down the following information from your network administrator:

1. A unique site name for each DVR. (Site names can be up to 32 characters and can include spaces.)

__________________________________________

__________________________________________

2. A unique system ID for each DVR. (You must change the system ID of each DX8100 you connect on a network segment to avoid conflicts. 
System IDs must start with a letter, can be up to 15 characters long, and cannot contain spaces or special characters.)

__________________________________________

__________________________________________

3. The TCP/IP port numbers that will be used by all DX8100 servers and clients on the network.

                                                                                                            9005 (fixed)                 13900 (fixed)     

Base PortUpgrade PortEmergency Agent PortInformation PortPing Port

(Default = 9002)(Default = 9003)(Default = 9004)(Default = 9005)(Default = 13900)

If your network is not configured for DHCP, obtain and write down the following information from your network administrator:

4. A unique IP address for each DVR. (For example, 10.0.0.101, 10.0.0.102, 10.0.0.103, etc.)

____.____.____.________.____.____.____

____.____.____.________.____.____.____

5. The subnet mask for each IP address. (For example, 255.0.0.0.)

____.____.____.________.____.____.____

____.____.____.________.____.____.____

6. The default gateway IP address for each unit.

____.____.____.________.____.____.____

____.____.____.________.____.____.____

7. The Primary DNS Server IP address for each unit.

____.____.____.________.____.____.____

____.____.____.________.____.____.____

8. The Secondary DNS Server IP address for each unit.

____.____.____.________.____.____.____

____.____.____.________.____.____.____

9. The Multicast Group IP address.

____.____.____.________.____.____.____

____.____.____.________.____.____.____
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Additional Warnings
There are important observations and warnings that you should be aware of.

• Read and keep all instructions, including the Important Safety Instruction sheet that was supplied with your DVR. 

• When using the networking capabilities of the DX8100, Pelco recommends that each DX8100 Series DVR be connected to a secure, private 
network. Do not directly connect your DVR to a public network such as the Internet. 

• It is recommended that the recorder be connected to an uninterruptible power supply (UPS) capable of supplying 2 A for 120 VAC power 
systems or 1 A for 230 VAC power systems.

NOTE:  The UPS feature is only supported for the Windows® 2000 operating system.

CAUTION:  The recorder should be installed in an air conditioned room where the temperature is maintained between 50° and 90°F 
(10° and 35°C) with relative humidity not to exceed 80 percent, noncondensing. 

WARNING: 

• When using the networking capabilities of the DX8100, you should connect each DX8100 Series DVR to a secure, private network. 
Do not directly connect your DVR to a public network such as the Internet. 

• All operating system files, applications, and utilities necessary to operate the DX8100 have been preinstalled on the unit. Do not install 
or use any software, including antivirus utilities, other than those installed at the factory.

• Do not install any additional hardware on the DX8100 Series DVR other than those devices listed in the documentation accompanying 
the unit. Do not remove, replace, or change any existing hardware without first consulting Pelco Product Support or an authorized Pelco 
service center.
C2629M-C (4/08) 9



Regulatory Notices
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

FCC, Class A (Models DX8132-M Series and DX8132-MA Series)

RADIO AND TELEVISION INTERFERENCE
This equipment has been tested and found to comply with the limits of a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may 
cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in 
which case the user will be required to correct the interference at his own expense. 

Changes and modifications not expressly approved by the manufacturer or registrant of this equipment can void your authority to operate this 
equipment under Federal Communications Commission’s rules.

In order to maintain compliance with FCC regulations shielded cables must be used with this equipment. Operation with non-approved 
equipment or unshielded cables is likely to result in interference to radio and television reception.

This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.

FCC, Class B (All other DX8100 Series)

RADIO AND TELEVISION INTERFERENCE
This equipment has been tested and found to comply with the limits of a Class B digital device, pursuant to part 15 of the FCC rules. These limits 
are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio 
communications. However there is no guarantee that the interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try 
to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and the receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

You may also find helpful the following booklet, prepared by the FCC: “How to Identify and Resolve Radio-TV Interference Problems.” This 
booklet is available from the U.S. Government Printing Office, Washington D.C. 20402.

Changes and Modifications not expressly approved by the manufacturer or registrant of this equipment can void your authority to operate this 
equipment under Federal Communications Commission’s rules.

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
10 C2629M-C (4/08)



Video Quality 

FRAME RATE NOTICE REGARDING USER-SELECTED OPTIONS

Pelco systems are capable of providing high quality video for both live viewing and playback. However, the systems can be used in lower quality 
modes, which can degrade picture quality, to allow for a slower rate of data transfer and to reduce the amount of video data stored. The picture 
quality can be degraded by either lowering the resolution, reducing the picture rate, or both. A picture degraded by having a reduced resolution 
may result in an image that is less clear or even indiscernible. A picture degraded by reducing the picture rate has fewer frames per second, 
which can result in images that appear to jump or move more quickly than normal during playback. Lower frame rates may result in a key event 
not being recorded by the system.

Judgment as to the suitability of the products for users’ purposes is solely the users’ responsibility. Users shall determine the suitability of the 
products for their own intended application, picture rate and picture quality. In the event users intend to use the video for evidentiary purposes in 
a judicial proceeding or otherwise, users should consult with their attorney regarding any particular requirements for such use.
C2629M-C (4/08) 11



Description
The DX8100 Series digital video recorders (DVRs) are professional security-level DVRs based on a new and innovative hardware platform that is 
powered by unparalleled and unique high-performance software. As the security requirements of your business expand into multiple sites and 
become more diversified, you need a professional DVR that you can quickly and effortlessly increase the channel and recording capacity. 

• The DX8100 is interoperable with your existing DX8000 DVRs, allowing you to build upon your existing security system. A DX8100 client 
can operate and administer both the DX8100 and DX8000 within the same network.

• When you need to quickly and easily add more security cameras, the new DX8100-EXP 16-channel expansion unit extends the 8- or 
16-channel DX8100 to 24 or 32 channels. With or without the channel expansion unit, all of the cameras can now take advantage of the 
increased frame rates of 2CIF and 4CIF recording. The DX8100 records video up to 480 images per second (ips) at a maximum CIF image 
size. If your security project requirements increase storage capacity, you can extend internal storage up to 3 TB. With the optional DX9200 
HDDI, you can further increase the DX8100 storage capacity. Alternatively, you can use the DX9200 HDDI as a redundant RAID solution.

• With the addition of a second monitor connected to the Dual Display Card, you can simultaneously view up to 72 cameras, allowing you to 
monitor live or playback video on as many as six displays.

• As your audio security needs grow, use the DX8108-AUD or DX8116-AUD audio option to add a total of 8 or 16 audio inputs. 

• Sophisticated video security applications require a network of DVRs to monitor multiple locations. The 10/100/1000 megabit Ethernet port 
supports today’s high-speed networks. You can network your DX8100 and DX8000 systems and remotely operate the DVRs for continuous, 
motion detection, alarm, ATM/POS, normal scheduled recording, and administer and view live and playback video. For time-critical security 
applications, you must ensure that all video recordings are synchronized to an accurate time source. The DX8100 supports the network time 
protocol (NTP), which allows you to synchronize all networked DX8100s to one NTP time server. Using expanded ATM/POS connectivity, you 
can connect up to 16 ATM/POS devices to the DX8100. System health check monitoring provides current operational status of the unit, 
ensuring maximum system uptime for critical video security needs.

WHAT IS A DVR?
A DVR is a video recording and playback device that incorporates all of the essential capabilities of a VCR but adds significant advantages. Like a 
VCR, video is recorded (from one or more cameras) and stored for later playback and retrieval. However, in a DVR, video data is recorded and 
stored on a hard disk instead of magnetic tape. Storing video in this manner facilitates instant, random access to data, as opposed to sequential 
access inherent to tape-based recording. This means no fast-forwarding or rewinding is necessary to locate the data a user wants to view or 
export. 

Another key advantage of hard disk is decreased maintenance. With no need to replace tapes, DVRs with hard disks can be left unattended for 
extended periods of time. Since video remains in the digital domain, data is easy to store, transport, and manipulate. Unlike analog video 
recordings, digital data does not suffer from a loss in quality when copied or moved from device to device. 

Because DVRs rely on hard disks instead of tape, data storage is virtually unlimited. Video data can also take advantage of compression 
technology to increase the efficiency of storage media. Modern DVRs, such as the DX8100, allow users to record, play back, and view live video 
simultaneously. Keeping data in a digital format means video can be easily backed up to a variety of storage media. This also means that 
alphanumeric information, such as date, time, and transaction statistics, can be synchronously recorded with video. 

FEATURES
This section describes new and additional DX8100 DVR features.

NEW PRODUCT FEATURES

The DX8100 v1.2 release includes new features as follows:

• Dual Display Card • Maximum increased storage capacity of 3 TB

• Expanded ATM/POS for as many as 16 devices • External RAID storage option

• System health check • Increased frame rate for 2CIF and 4CIF recording

• Windows XP Embedded • Standard analog output

• MUX card output • NTP time server compatible

• 2 built-in audio channels • Standard DVD-R writes to CD-R and DVD-R media

• Optional layer two multicasting • Up to 704 x 480 recording resolution (4CIF)

• Interoperable with DX8000 DVRs • Up to 32 camera inputs and outputs with auto termination

• 16-Channel expansion box option
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ADDITIONAL FEATURES

The DX8100 includes additional features as follows:

• 36 camera views for DX8100 server or client 

• Online help 

• Up to 32 channels of video and audio recording (optional) 

• 8/16/24/32 alarm inputs and 8/16/24 relay outputs 

• Camera view favorites 

• Instant playback 

• Quick menu option to turn relays on/off 

• Live audio over the network 

• Video loss event start and recovery time 

• Video loss event linked to an alarm 

• Up to 480 ips recording rate at 320 x 240 resolution (NTSC) 

• Client connects to up to 100 servers 

• Connect any five DX8100 servers in a network or any combination of DX8100 and DX8000 DVRs 

• Network bandwidth throttling 

• 10/100/1000 megabit Ethernet port 

• Multi-Event recording schedules 

• Multiple displays for live viewing or playback while recording 

• 6X digital zoom on playback 

• On-Screen PTZ control with positioning device programming capability 

• Includes remote PC, Web, and handheld client software 

• Pelco-Engineered compression technology offering high-quality and small file sizes 

• Local and remote administration, live, search, and playback viewing 

• Individual camera channel configuration 

• Display cameras from different sites on one screen 

• Dynamically adjustable frame rate and image quality for motion and alarm recording and pre-alarm recording 

• Pre- and post- alarm recording up to 60 seconds (up to 15 minutes with optional 512 MB RAM upgrade)* 

• Monitor system changes using activity logs 

• User-friendly and highly intuitive graphical user interface 

• Local and remote software upgrade capabilities 

• Multilevel password and user configuration 

• Automatic image watermarking 

• Multilingual support (English, French, German, Italian, Polish, Portuguese, Russian, and Spanish) 

• User-Definable PTZ presets, patterns, and preset tours 

• Print still images from video 

• Export video and still images in multiple formats, including DX8100 Native, AVI, ASF, BMP, TIFF, and JPEG 

• DX8100 Viewer included with video exports 

• API facilitates development and integration of third-party applications and XPortal

• Ability to configure any number of camera inputs for covert mode 

• Scheduled backup 

• Interoperable with DX8000 DVRs 

• Standard DVD-R burner writes to CDR and DVD-R media 

• NTP time server compatible 

• Up to 32 camera inputs and outputs with auto termination 

• KBD300A keyboard support for camera selection and PTZ control 

*Pre-alarm time estimate based on 16-channel recording at a resolution of 320 x 240 (CIF) and a frame rate of 5 ips.
C2629M-C (4/08) 13



MODELS
The DX8100 Series DVR is available in various model configurations. For example, the model number for a 32-channel system with 1000 GB 
storage, analog display, and audio input option is DX8132-1000MA. Typically, if an audio option is ordered, a 32-channel system comes with a 
32-channel audio option. The model number for a customized system is specified differently. For example, if you ordered a 32-channel system 
with 1000 GB storage and an 8-input audio option the model numbers would be DX8132-1000 (32 video channels) and DX8108-AUD (8 audio 
inputs) respectively. For more information about ordering customized configurations, contact your Pelco sales representative.
 

Table A.  Model Number Format

DX81XX – XXXXXX
Channels
Storage (GB)
Options

Channels Storage in GB Options
08 250 A = Audio
16 500 M = MUX
24 750 MA = MUX and Audio
32 1000

1500
2000
2250
3000

OPTIONAL ACCESSORIES
The table below describes DX8100 optional accessories. Refer to the documentation supplied with the optional accessories for installation 
instructions. 

Table B.  DX8100 Optional Accessories 

Option Number Description Reference Documentation
DX8100-EXP DX8100 16-channel expansion unit Kit C2636M
DX8100-ISCI DX8100 internal ultra 160 SCSI card C2635M
DX8108-AUD DX8100 8-channel audio input card C2638M
DX8116-AUD DX8100 16-channel audio input card C2638M
DX81XP-UPG Windows XP Embedded software upgrade for DX8100 C2666M
DX8100-512RAM DX8100 memory upgrade from 512 MB to 1 GB N/A
DX8108-MUX DX8100 8-channel multiplexed analog output display card C2665M
DX8116-MUX DX8100 16-channel multiplexed analog output display card C2665M
3530-10030-ADD Hot-swappable 3.0 TB External RAID 5 storage expansion unit
3530-10031-ADD Hot-swappable 6.0 TB External RAID 5 storage expansion unit
DX81HDD250KIT DX8100 SATA 250 GB upgrade C2639M
DX81HDD500KIT DX8100 SATA 500 GB upgrade C2639M
DX81HDD750KIT DX8100 SATA 750 GB upgrade C2639M
KBD300A KBD300A Universal keyboard (requires KBDKIT Refer to Appendix F: Connecting a KBD300A 

Keyboard on page 73 
KBDKIT/KBDKIT-X Remote keyboard wiring kit Refer to Appendix F: Connecting a KBD300A 

Keyboard on page 73 
VSI-PRO AVE™ Video serial interfaces for ATM/POS Refer to Appendix G: Connecting ATM/POS 

Devices on page 76
DX8100DSP-W2K DX8100 Dual Display Card upgrade for Windows 2000 C2637M
DX8100DSP-XP DX8100 Dual Display Card upgrade for Windows XP Embedded C2637M
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Parts List
DX8100 parts are listed as follows:

Qty Description
1 Recorder
2 Power cords (1 USA standard and 1 European standard)
1 Keyboard
1 Mouse
1 Rack mounting kit

2 Rack ears
2 Rack handles
2 Chassis brackets
2 Adjustable support rails (front)
2 Adjustable support rails (rear)
6 Screws, 8-32 x 0.375-inch, Phillips, pan head with lock washers
16 Screws, 10-32 x 0.375-inch, Phillips, flat head
4 Screws, 10-32 x 0.750-inch, Phillips, pan head with nylon washers
10 Screws, #4, sheet metal, pan head, Phillips, black, 0.375-inch

2 Keys in slot 2 and the main Capture card moved to slot 3.
1 or 2 Alarm input terminal blocks (green)

1 terminal block provides 8 alarm inputs
2 terminal blocks provide 16 alarm inputs

1 or 2 Relay output terminal blocks (blue)
1 relay output terminal block provides 8 relay outputs
2 relay output terminal blocks provide 16 relay outputs

1 Quick Start Installation guide
1 Quick Start Operations guide
1 AVG AntiVirus Installation manual (C2633M)
1 Symantec® AntiVirus Installation manual (C2643M)
1 McAfee® VirusScan® Installation manual (C2642M)
1 DX8100 Series Installation manual
1 DX8100 Recovery DVD
1 DX8100 Resource DVD

Includes DX8100 applications for the PC Client, Client Emergency Agent, Native Viewer, and Mobile Client; and both client and server 
operation/configuration manuals (C2630M and C2631M)

1 Nero® Express 7 Essentials CD burning software, version 7.2.3.3 
C2629M-C (4/08) 15



Application Examples

Figure 3.  Sample System with Multiple DX8100s and Multiple Clients

IMPORTANT NOTE. PLEASE READ. 
The network implementations in this document are shown as general representations only and are not intended to show detailed network 
topologies. Your actual network will differ, requiring changes or perhaps additional network equipment to accommodate the systems as 
illustrated. Please contact your local Pelco representative to discuss your specific requirements.

PC CLIENT

LAN/WAN

DX8100 SERVER DVR

CAMERA

DX8100

FAST ETHERNET SWITCH

DX8100

DX8100

DX8100

Figure 2.  Sample System with Multiple DX8100sFigure 1.  Sample System with Single 

WWW CLIENT

MOBILE CLIENT

DX8100 SERVER DVR

DX8100 SERVER DVR

LAN/WAN

DX8100 SERVER DVR

DX8100 SERVER DVR
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Figure 4.   Sample DX8100 Network with Dual Display and DX8000, Third-Party Domes, ATM/POS, and KDB300A Keyboard

 

Refer to the DX8100 Series Operation/Configuration manual (C2630M) for instructions on how to operate and program the DVR.
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DX8100 
EXPANSION UNIT

CAMERAS 
(9-24)
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(1-8) KBD300A

DX8100 SERVER 2

DX8100 SERVER 1

DX8008 SERVER 3

NETWORK

DX8100 SERVER 4
CAMERAS 

(1-16)

CAMERAS 
(17-32)

HYDRA

HYDRA
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(9-24)

CAMERAS 
(1-8)
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Equipment Rack Mounting 

Figure 6.  Attaching Rack Ears and Handles

4. Using the remaining six #4 sheet metal Phillips 0.375-inch pan head screws, attach the two chassis brackets to the left and right sides of 
the unit. Refer to Figure 7.

5. Assemble both sets of front and rear mounting rails using three 8-32 x 0.375-inch pan head screws and locking washers for each side.

6. Using six of the 10-32 x 0.375 Phillips flat head screws per side, attach the assembled mounting rails to a 19-inch (48.26 cm) equipment 
rack or console.

7. Place the unit onto the mounting rails. It should slide in and out of the rack easily. This step may require two persons to lift and slide the 
unit into place.

8. Fasten the rack ears to the equipment rack using the four 10-32 x 0.750-inch pan head screws and nylon washers.

You should allow at least one rack unit (1.75 inches or 4.44 cm) of spacing between units. Slots and openings in the cabinet provide 
ventilation and prevent the unit from overheating. Do not block these openings. Never place the DVR near or over a radiator or heat register. 
Do not place it in a built-in installation, such as a rack, unless proper ventilation is provided.

Figure 5.  Remove Left and Right Side Plates

2. Attach the handles to the rack ears using the four provided 10-32 x 0.375-inch Phillips screws. Refer to Figure 6.

3. Using two of the supplied #4 sheet metal Phillips 0.375-inch pan head screws for each side, attach the rack ears to the unit.

(4) SCREWS,
10-32 X 0.375-INCH
PHILLIPS, FLAT HEAD
WITH WASHERS

RACK EAR

(4) SCREWS, #4, SHEET METAL, PAN HEAD,
PHILLIPS BLACK, 0.375-INCH (2 EACH SIDE)

To install the unit in an equipment rack:

1. Remove the 12 screws fastening both left and right side plates to the unit. Save the side plates and screws for possible future use.
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Figure 7.  Rack Mount Installation

RECORDER/VIEWSTATION

BRACKET (SIDE VIEW)

(6) SCREWS, #4, SHEET METAL, PAN HEAD,
PHILLIPS BLACK, 0.375-INCH (3 EACH SIDE)

SLOTTED HOLES
TOWARDS FRONT
OF UNIT

TAPERED ENDS
TOWARDS REAR
OF UNIT

(6) SCREWS,
8-32 X 0.375-INCH,
PAN HEAD WITH LOCK 
WASHERS

(8) SCREWS,
10-32 X 0.375-INCH,
FLAT HEAD

REAR MOUNTING RAIL

FRONT MOUNTING RAIL

RACK

(4) SCREWS,
10-32 X 0.375-INCH
FLAT HEAD
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Back Panel Layout

Figure 8.  Back Panel Layout

Autoranging AC Power Input (voltage range between 100 VAC and 240 VAC, 50/60 Hz)

Alarm Inputs: 16 normally closed inputs

Camera Outputs: 8 or 16 BNC camera outputs

Camera Inputs: 8 or 16 BNC camera inputs

Relay Outputs: 16 normally open outputs

Dual Display Card Switch and Outputs (optional): Switch selects VGA connector (down) or composite BNC (up) output

Audio Inputs (optional): 8 or 16 channels

RJ-45 Extended Peripheral Connectors (RS-422/RS-485 compliant)

BNC Programmable Analog Display Output 

Audio Input (standard): One miniature phone jack for line in

Audio Output (standard): One miniature phone jack for audio output

Mic Input (standard): One 2-channel (right/left) miniature phone jack for line in

High-Speed USB 2.0 Ports: Two USB ports on front of unit and four on rear of unit for connecting a USB mouse and keyboard

Ethernet Adapter Port: 100 Mbps port

VGA Monitor Output: 15-pin output

9-Pin Serial Port: COM1

LPT1 Printer Port: 25-pin port

Keyboard (PS/2) Input 

Mouse (PS/2) Input

IMPORTANT NOTE. PLEASE READ. 
The network implementations in this document are shown as general representations only and are not intended to show detailed network 
topologies. Your actual network will differ, requiring changes or perhaps additional network equipment to accommodate the systems as 
illustrated. Please contact your local Pelco representative to discuss your specific requirements.

IN1 IN2 IN3 IN4 IN5 IN6 IN7 IN8 IN9 IN10 IN11 IN12 IN13 IN14 IN15 IN16
OUT16OUT15OUT14OUT13OUT12OUT11OUT10OUT9OUT8OUT7OUT6OUT5OUT4OUT3OUT2OUT1

ALARM INPUTS RELAY OUTPUTS
1 2 2 4 5 6 7 8 GND
9 10 11 12 13 14 15 16

1 2 2 4 5 6 7 8 GND
9 10 11 12 13 14 15 16
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Hardware Setup

Figure 9.  Basic Connections

BASIC CONNECTIONS

VGAKEYBOARDMOUSEVGA
POWER

CONNECTION

SPECTRA®CAMERA

Make the following connections on the rear of the recorder (refer to Figure 9).

Connect the appropriate power cord to the back of the unit and to a power source. 

The DX8100 contains an autoranging power supply. It is recommended that the recorder be connected to an UPS capable of supplying 2 
A for 120 VAC power systems or 1 A for 230 VAC power systems.

NOTE: The UPS feature is only supported for Windows 2000 operating system.

Connect the primary VGA monitor (not supplied).

 Connect the mouse to a USB input. 

Connect the keyboard to a USB input.

Connect a second monitor (VGA shown, but not supplied). 

NOTE:  The second monitor must be connected to the Dual Display Card before you start the DX8100. The DX8100 DVR is shipped from 
the factory with the Windows desktop enabled so it can be extended to the second monitor. If the DX8100 is running before the second 
monitor is connected, the second monitor is not detected when the unit starts, the desktop is not extended to the second monitor, and 
video is only displayed on the primary monitor. If this occurs, you must manually configure Windows to display video on the extended 
monitor. For information about connecting and configuring the second monitor, refer to Appendix C: Connecting the Dual Display Card on 
page 66. After Windows recognizes the extended monitor for the first time, if the extended monitor is connected to the unit when the 
DX8100 restarts, the extended monitor configuration is maintained and you do not have to reconfigure Windows again. 

Connect the cameras to the BNC connectors. Refer to Table C for video coaxial cable requirements. Connect power to the cameras.
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Table C.  Video Coaxial Cable Requirements

Cable Type* Maximum Distance
RG59/U 750 ft (229 m)
RG6/U 1,000 ft (305 m)
RG11/U 1,500 ft (457 m)

*Minimum cable requirements:

75-ohm impedance

All-copper center conductor

All-copper braided shield with 95% braid coverage

NETWORK SETUP
The DX8100 Series DVR supports remote viewing and administration in client-server and peer-to-peer configurations. The DX8100 is compatible 
with the TCP/IP protocol and Fast Ethernet (1000BaseT) network connection. Consult your network administrator before installing the DX8100 to 
avoid possible network conflicts.

For TCP/IP access, connect the DX8100 to a 100 Mbps or 1 Gigabit, switched Ethernet network. Use standard Cat5 or better UTP cable with RJ-45 
connectors.

Figure 10.  LAN/WAN Cable Connection

To configure the DX8100 hardware for network access:

1. Connect one end of the UTP cable to the network port on the back panel of the DX8100 as shown in Figure 10.

2. Connect the other end of the UTP cable to an available port on a standard Fast Ethernet switch.

ROUTER

LAN/WAN
INTERNET

FAST ETHERNET SWITCH

CAT5 UTP
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RS-422/RS-485 COMMUNICATION PORT SETUP
The DX8100 Series DVR features four RS-422/ RJ-45 communication ports. All ports are compatible with both RS-422 and RS-485 interface 
standards. Each port can communicate with and control a variety of ATM/POS, PTZ, third-party dome devices, and Pelco’s Spectra® III dome 
enclosures and Esprit® positioning systems.

The example configuration illustrated in Figure 11 shows a DX8100 connected directly to up to four PTZ devices and indirectly to up to 16 devices 
through Pelco’s CM9760-CDU-T code distribution unit. Figure 12 illustrates the connection of a variety of RS-422/RS-485 compatible devices 
including the DX8100. This example highlights the P and D protocol data merging capability of Pelco’s CM9760-DMR data manager.

Figure 11.  RS-422/RS-485 Configuration: Example 1

To operate properly, devices must be compatible with either the RS-422 or RS-485 interface standards and must be able to communicate using 
Pelco’s P, D, or Coaxitron® protocols, or third-party dome protocols.

1. Using unshielded twisted pair (UTP) cable, connect up to four RS-422/RS-485 compatible devices to the RJ-45 connector jacks provided on 
the rear panel of the unit.

You should use 22 or 24 gauge UTP cable. Category 5 UTP is recommended for cable runs greater than 400 feet.

2. Set the communication parameters for both the DX8100 and the PTZ device. Communication parameters are baud rate, parity (odd or even), 
number of parity bits, number of data bits, and number of stop bits.

Refer to RS-422/RS-485 Communication Port Software Configuration on page 38 for instructions on setting up your DVR’s communication 
parameters. Refer to the documentation included with your PTZ device for instructions on configuring its communication settings.

SPECTRA
PIN 1

PIN 8

PIN 1 = TX+
PIN 2 = TX-
.
.
.
.
PIN 7 = RX-
PIN 8 = RX+

PTZPTZPTZ

CM9760-CDU-T

ROLLOVER CABLE PIN 1 = TX+
PIN 2 = TX-
.
.
.
.
PIN 7 = RX-
PIN 8 = RX+

PIN 8
PIN 1
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Figure 12.  RS-422/RS-485 Configuration: Example 2

Figure 13.  Cable Wiring Schemes

Different types of devices may require alternative cable wiring schemes. Wiring schemes commonly used by Pelco products include straight and 
rollover types. Refer to the documentation included with your PTZ device to ensure that cables and connectors are wired appropriately. Figure 13 
illustrates straight and rollover cable wiring schemes.
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8

PIN
1
2
3
4
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7
8

PIN
1
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4
5
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PIN
1
2
3
4
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6
7
8

RJ-45

STRAIGHT CABLE

ROLLOVER CABLE

RJ-45

RJ-45 RJ-45

ROLLOVER CABLE

KBD300A

PTZ
1-16

CM6800

CM6800

CM9760-DMR
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IN14 IN15 IN16
OUT16OUT15OUT14
ALARM INPUT INSTALLATION
The DX8100 has either 8 or 16 dry contact alarm inputs, depending on your system’s configuration. Each input is programmed to function as 
either a normally open or normally closed circuit.

Figure 14.  Alarm Terminal Installation

To wire an alarm input:

1. Insert the green terminal blocks into the alarm sockets on the back panel of the recorder.

2. Connect one wire from the source device to one of the sensor input terminals 1 through 16.

3. Connect a second wire from the source device to a GND terminal.

4. Refer to the DX8100 Operation/Programming manual for information on how to program the alarm inputs.

IN1 IN2 IN3 IN4 IN5 IN6 IN7 IN8 IN9IN9 IN10 IN11 IN12 IN13
OUT13OUT12OUT11OUT10OUT9OUT9OUT8OUT7OUT6OUT5OUT4OUT3OUT2OUT1

ALARM INPUTS RELAY OUTPUTS
1 2 2 4 5 6 7 8 GND
9 10 11 12 13 14 15 16

1 2 2 4 5 6 7 8 GND
9 10 11 12 13 14 15 169 10 11 12 13 14 15 16

CRT

ALARM
OUTPUT 1 GND
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IN14 IN15 IN16
OUT16OUT15OUT14
RELAY OUTPUT INSTALLATION
The DX8100 has either 8 or 16 relay outputs, depending on your system’s configuration. Each output is programmed to function as either a 
normally open or normally closed circuit. A signal from a relay output will operate the device connected to the output. The maximum relay power 
rating is 120 VAC, 0.5 A; 24 VDC, 1 A.

Figure 15.  Relay Terminal Installation

To wire a relay output:

1. Insert the blue terminal blocks into the relay sockets on the back panel of the recorder.

2. Connect one wire from the device to one of the relay output terminals 1 through 16.

Relay outputs do not have to correspond numerically to alarm inputs. All sensor input and relay output actions can be linked through 
programming.

3. Connect a second wire from the relay device to a GND terminal.

4. Refer to the DX8100 Operation/Programming manual for information on how to program relay outputs.

IN1 IN2 IN3 IN4 IN5 IN6 IN7 IN8 ININ9 IN10 IN11 IN12 IN13
OUT13OUT12OUT11OUT10OUOUT9OUT8OUT7OUT6OUT5OUT4OUT3OUT2OUT1

ALARM INPUTS RELAY OUTPUTS
1 2 2 4 5 6 7 8 GND
9 10 11 12 13 14 15 16

1 2 2 4 5 6 7 8 GND
9 10 11 12 13 14 15 169 10 11 12 13 14 15 16

CRT

RELAY
OUTPUT 1 GND
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Software Setup

STARTING THE UNIT 

Figure 16.  Front Panel and Power Switch

WARNING:  Be sure to put on gloves before removing or inserting the filter.

Once the system has been installed and basic connections have been made, open the front panel of the DVR. Press the power switch. Wait while 
the unit starts (this may take several minutes).

POWER HDD

USB

POWER SWITCH

LOGGING IN FOR THE FIRST TIME 
To access the features of the DX8100 Series DVR, each user must log in with a valid user name and password. User names and passwords are 
case sensitive. 

There are four user access levels or groups that can be configured on the DX8100. Access levels range from the Administrator group, with the 
most rights and privileges, to the Restricted group, with the least rights and privileges. For information about configuring access levels, refer to 
the Definition of User Access Levels section of the DX8100 Operation/Programming manual for information on user group rights and permissions.

The DX8100 comes equipped with two built-in user accounts. Each time the unit is started, a default user account called “Guest” is automatically 
activated. The Guest account is granted only limited access to the DX8100 and is allowed no access to system configuration utilities. A second 
built-in user account, named “Admin”, provides full access to the operations and configuration features of the DX8100.

For security reasons, you are prompted but not required to change the Admin password immediately after logging in for the first time. Passwords 
must be between six and ten characters long and cannot include spaces or special characters. Follow the directions on the next page to change 
the Admin password.

Figure 17.  User Log-in Dialog Box

To log in with the Admin account:

1. Click File > User Log-in.

2. Enter Admin in the User name field and Admin in the Password field.

3. Click OK.

If you are logging in for the first time, the system prompts you to complete the mandatory password change for the Admin account. In this case, 
the Set Admin Password dialog box opens automatically. You must change the password for the Admin account. If you want to keep the default 
password, click Cancel. However, because of security reasons, Pelco recommends that you change the password.
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Only users with Administrator and Power User accounts are allowed access to DX8100’s setup functions.

Figure 18.  Set Admin Password Dialog Box

To complete the prompted password change for the Admin account:

1. Enter a new password in the New Password field.

2. Enter the password again in the Confirm Password field to confirm the password.

3. Click OK.

�

�

�

SHUTTING DOWN
You must have Power User or Administrator access to shut down the DX8100. For more information about user security levels, refer to the 
DX8100 Operation/Programming manual. You must also have a Windows password to shut down the DX8100. For information on the Windows 
default password, refer to the Important Security Information for System Administrators guide.

Figure 19.  Shut Down Dialog Box

To shut down the DX8100 Series DVR:

1. Go to File > Exit.

2. Select Shut down.

3. Click OK.
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EXITING TO WINDOWS OPERATING SYSTEM
Some of the steps involved in the configuration of a DX8100 Series DVR require exiting to the operating system. You must have Administrator 
access to exit to the Windows operating system. For more information about user security levels, refer to the DX8100 Operation/Programming 
manual. You must also have a password to exit from the DX8100 application to the Windows operating system. For information on the Windows 
default password, refer to the Important Security Information for System Administrators guide.

Figure 20.  Shut Down Dialog Box

The Log On to Windows dialog box opens.

4. Enter the Windows password and click OK. The system logs you into the Windows operating system.

To exit the DX8100 application and log into the Windows operating system:

1. Go to File > Exit.

2. Select Exit to Windows. The Shut down dialog box opens.

3. Click OK.

SETTING THE SYSTEM LANGUAGE
The DX8100 supports eight languages. The DVR comes from the factory configured for English (United States). To configure the system properly 
for a language other than English, you must change the regional setting in the Windows operating system and the language setting of the 
DX8100. The following regional settings are available for the DX8100:

• English (United States)

• French (France)

• German (Germany)

• Italian (Italy)

• Polish

• Portuguese (Brazil)

• Russian

• Spanish (Spain)

English (United States) is the default setting.
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CONFIGURING THE REGIONAL SETTINGS IN THE WINDOWS OPERATING SYSTEM

Figure 22.  Regional Options Dialog Box

4. Click the Advanced tab. 

Figure 21.  Windows XP Embedded Control Panel

3. Double-click Regional and Language Options. The Regional and Language Options dialog box opens.

In the example below, the location is changed from English (United States) to Spanish (Spain). 

1. Exit the DX8100 application and return to the Windows operating system. Refer to Exiting to Windows Operating System on page 29.

2. Click Start > Settings > Control Panel. The Control Panel appears. 
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Figure 25.  Change Regional Options Dialog Box

Figure 24.  General Dialog Box

7. Click Yes. The Change Regional Options dialog box opens, prompting you to restart the DX8100.

8. Click Yes.

Figure 23.  Regional Options Dialog Box

6. Click Apply. The General dialog box opens. 

5. Click the language arrow to open the drop-down list, and then change the selection to Spanish (Spain). 

The new settings take effect after the computer restarts. The DX8100 will support Spanish settings for numbers, currency, times and dates.

Follow these same steps to change the location back to English (United States) or to select another location.
C2629M-C (4/08) 31



CONFIGURING THE LANGUAGE SETTING OF THE DX8100

Figure 26.  System Page: Selecting the Language

You must have Administrator or Power User access to configure the language setting of the DX8100.

1. Start the DX8100 if it is not already running, and then log in as a Power User or Administrator.

2. Click .

3. Click . The System page is displayed.

4. Select the appropriate language from the drop-down box.

5. Click Update. The Restart dialog box opens.

6. Click Yes. The DX8100 restarts.
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SETTING THE SYSTEM TIME
Time should be set on the DX8100 before it is put into use. Setting the internal clock for each DVR on the network ensures that each accurately 
reflects the local time.

Figure 27.  Setting the System Time

To set system time:

1. Click .

2. Click . The System page is displayed.

3. From the Date/Time drop-down box, select the current month, day, and year.

4. Select the current time.

5. Click Update.

6. Select the correct time zone from the drop-down box.

7. Click Update.

8. Click Apply.
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ENABLING AND USING CTRL+ALT+DEL
Enabling the Ctrl+Alt+Del key combination allows you to open the Windows Task Manager dialog box to perform Windows system               
administration tasks. To complete the procedure, you must be logged on to the DX8100 as an administrator or a member of the administrators 
group on a computer that is part of a network domain. 

NOTE:  The DX8100 keyboard is remapped. To see which keys replace the Ctrl and Alt keys, refer to the Important Security Information for 
System Administrators guide.

To enable the Ctrl+Alt+Del key combination:

1. Click .

2. Click . The System page is displayed.

3. From the Setup Ctrl + Alt + Del key combination area, click the Enable Ctrl+Alt+Del key combination selection check box.

4. Click Apply.

5. Reboot the DX8100. 

USING CTRL+ALT+DEL

You must enable the Ctrl + Alt + Del key combination and verify your actual keyboard mapping. In some cases, the DX8100 keyboard is remapped 
and the actual Ctrl and Alt key function is assigned to other keys. For information on which keys replace the Ctrl and Alt keys, refer to the    
Important Security Information for System Administrators guide.

Ctrl+Alt+Del allows you to access the Windows Task Manager dialog box from within the DX8100 shell. When you exit the Windows              
environment, you are returned to the DX8100 shell. In this case, you do not have to log back into the DX8100.

To access the Windows Task Manager dialog box:

1. Press the assigned keyboard keys that implement the Ctrl + Alt + Del function. The Windows Security dialog box opens.

2. In the Windows Security dialog box, click Task Manager. The Windows Task Manager window opens.

To return to the DX8100 shell without rebooting the DX8100, exit the Windows Task Manager dialog box.

NETWORK SOFTWARE CONFIGURATION
Using the TCP/IP protocol, up to five DX8100 Series DVRs can be networked together for remote viewing and management. In addition, up to five 
simultaneous PC, web, and mobile clients can connect to each DVR. The DX8100 Series DVR supports both static IP addressing and dynamic 
addressing through Dynamic Host Configuration Protocol (DHCP). Consult your network administrator for more information regarding IP address 
configuration.

The system must be turned on, connected to a network, and you must be logged in with either Power User or Administrator access to configure 
network software settings. You must reboot the DVR for any network configuration changes to take effect.

To begin the network setup process:

1. Click .

2. Click . The Network page is displayed.

3. Click the Network tab if it is not already visible.

4. Enter a new name for your DVR in the Site Name field. (Site names can be up to 30 characters in length. The default site name is DX8100.)

5. Enter a unique system ID for your DVR in the System ID field. (System IDs must start with a letter, must be 15 characters or less, and cannot 
include spaces or special characters.)

Your DVR’s site name is used to identify your system to clients and other DX8100 servers. Your DVR’s system ID is used to uniquely identify 
your system on a local area network (LAN). System IDs are required to prevent possible conflicts with other network devices.
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Figure 28.  Network Setup Page: Software Configuration

6. Proceed to the steps for setting up DHCP or Static IP addressing in the following sections.

DHCP SETUP

Your network must support DHCP, and an active DHCP server must be present for dynamic addressing to work. Consult your network 
administrator for more information.

Figure 29.  DHCP Setup

To configure the DVR to acquire a dynamic IP address through DHCP:

1. Click .

2. Click . The Network page is displayed.

3. Click the check box labeled Obtain An IP Address Automatically (DHCP).

4. Click Apply.
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STATIC IP SETUP

Figure 30.  Static IP Setup

To set up a static IP address, enter the following information in the fields provided. This information can be obtained from your network 
administrator.

1. Verify that the Obtain An IP Address Automatically (DHCP) check box is not selected.

2. Enter a unique IP address (for example, 10.0.0.101). The last three digits must be different for each recorder (for example, 101, 102, 103, 
and so forth).

3. Enter the subnet mask (for example, 255.0.0.0).

4. Enter the default gateway address (the IP address of the default router on your immediate network segment).

5. Click Apply.

TCP/IP PORT AND BANDWIDTH THROTTLE SETUP

The DX8100 uses the TCP/IP networking protocol to communicate over LAN and WAN networks. TCP/IP uses logical network ports to organize 
data transmissions and to ensure that data packets are delivered to the proper application. For example, e-mail is traditionally delivered through 
TCP/IP port 25 and web pages through port 80. The ports assigned to direct video and control information into and out of the DX8100 are listed 
below in Table D.

You should keep port numbers set at their default values unless there is a known conflict with your existing network infrastructure. Consult your 
network administrator before changing any port information on the DX8100. Consult your network administrator when assigning or changing the 
port numbers. Make sure that ports are not blocked by a firewall.

Table D.  TCP/IP Ports Used by the DX8100

Port 
Number

User 
configurable Function

9002 Yes Base port for transmission of video, audio, and interface data
9003 Yes Software upgrade
9004 Yes Emergency agent notification
9005 No Information port
13900 No Ping port

To configure TCP/IP ports and bandwidth throttle:

1. If necessary, enter a new base port number (9002 is the default).

2. If necessary, enter a new software upgrade port (9003 is the default).

3. Drag the network bandwidth throttle slider to the desired value. (Client bandwidth can be adjusted from a minimum of 256 Kbps to a 
maximum of 10 Mbps in increments of 256 Kbps.)
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Figure 31.  Base Port and Bandwidth Throttle Setup

4. Click Apply.

ACCESSING NETWORK INFORMATION

Changes in network settings may not show up immediately in the IP Configuration status box. Allow up to 30 minutes for settings to update or 
reboot your DVR for settings to change immediately.

Figure 32.  IP Configuration Status Box

2. Click OK to return to the Network page.

To access network information such as IP and default gateway addresses:

1. Click Network Information. The IP Configuration status box is displayed.

DNS/WINS SETUP

If your network supports DNS or WINS services, follow the instructions below:

1. Click the DNS/WINS tab.

2. Do one of the following:
a. If you are using dynamic IP addressing through a DHCP server, click the “Obtain DNS/WINS info from DHCP” check box.

or

b. If you are using static IP addressing, provide the following information in the appropriate fields. This information can be obtained from 
your network administrator.

• Primary DNS server IP address.

• Secondary DNS server IP address.

• Primary WINS server IP address.

• Secondary WINS server IP address.
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Figure 33.  DNS/WINS Setup

3. Click Apply to update the configuration.

RS-422/RS-485 COMMUNICATION PORT SOFTWARE CONFIGURATION
The system must be powered on, and you must be logged in as a Power User or Administrator to configure communication port settings.

Figure 34.  RS-422/RS-485 Port Setup Page

4. From the drop-down box, select Ports 1 to 4. None is the default setting in the selected device drop-down box. In this case, the port settings 
drop-down boxes are not available.

5. In the selected device drop-down box, select a device. The port settings drop-down boxes are available.

To configure the RS-422/RS-485 ports in software:

1. Click .

2. Click .

3. Click the Port/Device tab. The Port/Device page is displayed.
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6. Configure the port settings using the drop-down boxes provided (refer to Table E.) Refer to the instructions that came with your peripheral 
device for correct settings.

7. Click Apply.

CLIENT SOFTWARE SETUP
This section describes how to install and setup DX8100 client software.

RECOMMENDED SYSTEM REQUIREMENTS

The following are the minimum recommended system requirements for the DX8100 PC client, web client, and Emergency Agent software 
applications.

• Processor: Intel® Pentium® 4 with 2800 MHz minimum processor speed

• Memory: 256 MB of RAM

• Video: AGP VGA card with minimum of 64 MB video RAM, 1024 x 768 or 1280 x 1024 display resolution, 32-bit color, and DirectX® 8.1 or 
later hardware acceleration

• 500 MB of free disk space

• Monitor: SVGA or XGA with 1024 x 768 or 1280 x 1024 resolution, 32-bit color

• Operating System: Windows 2000 (SP4) or Windows XP Professional

• Microsoft® Internet Explorer® Version 5.5 or later

Figure 35.  Resource CD Screen: PC Client Installation Option

INSTALLING THE PC CLIENT APPLICATION
1. Start the Windows operating system.

2. Close all programs, including any antivirus software.

3. Insert the DX8100 Resource CD into the CD/DVD drive of your PC and wait for the window to open.

Table E.  RS-422/RS-485 Port Settings

Setting Options
Device None or multiple devices
Interface Mode RS-422 or RS-485
Baud Rate 1200, 2400, 4800, 9600, 19200, 28800, 38400, 57600, or 115200
Parity None, Odd, or Even
Data Bits 5, 6, 7, or 8 bits
Stop Bits 1 or 2 bits
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Figure 38.  DX8100 Client Setup Dialog Box

Figure 37.  DX8100 Security Setup Dialog Box

6. Verify that the Install IPSec Configurations check box is selected.

IPSec is a standard security protocol used by the DX8100 Series DVR and its clients to communicate safely over a network. 

7. Click Next. The DX8100 Client Setup dialog box opens.

Figure 36.  Resource CD Software Installation Options

5. Click Client. The DX8100 Security Setup dialog box opens.

4. Click Software. The DX8100 software installation options are displayed.
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Figure 40.  Select Installation Folder Dialog Box

Figure 39.  Software License Agreement Dialog Box

9. Read the license agreement and select the “I accept this License Agreement” check box.

10. Click Next. The Select Installation Folder dialog box opens.

8. Click Next. The Software License Agreement dialog box opens.
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Figure 41.  Installation is Completed Successfully Dialog Box

12. Click Finish to complete the installation process.

11. Click Next to accept the default installation folder. After the DX8100 Client software is installed, the “Installation is completed 
successfully” dialog box opens.

ENABLING IPSEC SECURITY SERVICES

In order to communicate with a networked DX8100 Series DVR, IPSec security must be enabled on your computer. To see the Manage IPSec 
Settings menu option from the Start menu, the Start menu has to be changed to the Classic View. 

Figure 42.  Enabling IPSec Security for the PC Client Application

3. Select the Enable DX8100 IPSec Policy check box if it is not already selected.

4. (If applicable) Set the Start menu to its previous view.

To enable IPSec security services:

1.  Do one of the following:

• Verify that the Start menu is in the Classic View.
• Set the Start menu to the Classic View.

2. Go to Start > Manage IPSec Settings. The DX8100 IPSec Policy dialog box opens.
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DISABLING IPSEC SECURITY SERVICES

Disabling IPSec security services may hamper your PC’s ability to communicate with DX8100 servers. Consult your system administrator before 
disabling IPSec security. For information about using the DX8100 Client application, refer to the DX8100 Client Applications manual.

Figure 43.  Disabling IPSec Security for the PC Client Application

3. De-select the Enable DX8100 IPSec Policy check box.

4. (If applicable) Set the Start menu to its previous view.

To disable IPSec security services:

1.  Do one of the following:

• Verify that the Start menu is in Classic View.
• Set the Start menu to Classic View.

2. Go to Start > Manage IPSec Settings. The DX8100 IPSec Policy dialog box opens.

INSTALLING THE CLIENT EMERGENCY AGENT APPLICATION

Figure 44.  Resource CD Screen: Emergency Agent Installation Option

To install the Emergency Agent application:

1. Start the Windows operating system. 

2. Close all programs, including any antivirus software.

3. Insert the DX8100 Resource CD into the DVD drive of your PC and wait for the DX8100 Resource CD window opens.
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Figure 47.  Emergency Agent Software License Agreement Dialog Box

Figure 46.  DX8100 Emergency Agent Setup Dialog Box

6. Click Next. The Software License Agreement dialog box opens.

Figure 45.  Resource CD Software Installation Options

5. Click Emergency Agent. The DX8100 Emergency Agent Setup dialog box opens.

4. Click Software. The DX8100 software installation options are displayed.
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Figure 49.  Installation is Completed Successfully Dialog Box

10. Click Finish to complete the installation process.

Figure 48.  Select Installation Folder Dialog Box

9. Click Next to accept the default installation folder. After the Emergency Agent software is installed, the “Installation is completed 
successfully” dialog box opens.

7. Read the license agreement and select the “I accept this License Agreement” check box.

8. Click Next. The Select Installation Folder dialog box opens.
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INSTALLING THE DX8100 VIEWER

Figure 51.  Resource CD Software Installation Options

Figure 50.  Resource CD Window_C2629M-A_0001

4. Click Software. The DX8100 software installation options are displayed.

To install the DX8100 Viewer:

1. Start the Windows operating system. 

2. Close all programs, including any antivirus software.

3. Insert the DX8100 Resource CD into the DVD drive of your PC and wait for the window to open.
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Figure 53.  Software License Agreement Dialog Box

7. Read the license agreement and select the “I accept this License Agreement” check box.

Figure 52.  DX8100 Viewer Dialog Box

6. Click Next. The Software License Agreement dialog box opens.

5. Click DX8100 Viewer. The DX8100 Viewer Setup dialog box opens.
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Figure 55.  Installation is Completed Successfully Dialog Box

10. Click Finish to complete the installation process.

Figure 54.  Select Installation Folder Dialog Box

9. Click Next to accept the default installation folder. The DX8100 Viewer software is installed, and the “Installation is completed 
successfully” dialog box opens.

8. Click Next. The Select Installation Folder dialog box opens.

INSTALLING THE DX8100 WEB CLIENT 

The first time you use a web browser to connect to a DVR server, an ActiveX® control application is downloaded and installed on your local 
computer. This control facilitates usage of the web client’s interactive features. Pelco recommends that you only use Internet Explorer because 
the DX8100 Web Client application is not compatible with Netscape Navigator®.

To install the DX8100 Web Client application:

1. Install and enable IPSec security services. For instructions on installing IPSec security services, refer to Installing the PC Client Application 
on page 39 or Installing the Client Emergency Agent Application on page 43. 

You must install either the PC Client application or the Client Emergency Agent application to install IPSec security services.

2. Start the Microsoft Internet Explorer web browser.
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Figure 57.  Security Warning Dialog Box

5. Click Yes. 

6. Wait while the ActiveX controls are downloaded to your PC and your browser software is updated.

Figure 56.  Enter Network Password Dialog Box

4. Click OK. The DX8100 Web client ActiveX control installation dialog box opens.

3. Enter the IP address of one of the DX8100 servers you want to connect to in the address bar. The Enter Network Password dialog box opens.
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RECOMMENDED SYSTEM REQUIREMENTS FOR MOBILE (PDA) CLIENT

The recommended system requirements for a mobile (PDA) client are as follows:

• PDA Hardware: A Pocket PC-compatible handheld device
• Processor: Intel Xscale®, compatible with a minimum processor speed of 400 MHz
• Memory: 64 MB of RAM
• Video: TFT liquid crystal display with minimum 240 x 320 display resolution, 64K colors
• Operating System: Microsoft Pocket PC 2002 or later
• A PC with Windows operating system and Microsoft ActiveSync® version 3.5 or later installed
• Wired or wireless networking capability

Figure 58.  Resource CD Window: Mobile Client Installation Option

INSTALLING THE MOBILE (PDA) CLIENT APPLICATION
1. Install ActiveSync on your Windows PC if it is not already present.

2. Connect your handheld device to your PC.

3. Turn on your handheld device if it is not already running.

4. Insert the DX8100 Resource CD into the DVD drive of your PC, and wait for the DX8100 Resource CD window to open.
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Figure 60.  Pocket PC Installation Dialog Box

Figure 59.  Resource CD Software Installation Options

6. Click Mobile Client Software. The Pocket PC installation dialog box opens.

5. Click Software. The DX8100 software installation options are displayed.
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Figure 63.  Application Downloading Complete Dialog Box

Figure 62.  Installing Applications Dialog Box

10. Click Yes to accept the default installation directory. 

11. Wait while ActiveSync copies the DX8100 Mobile Client program files to your handheld device, and then click OK in the Application 
Downloading Complete dialog box.

Figure 61.  License Agreement Dialog Box

8. Read the license agreement and select the “I accept the terms of the license agreement” check box.

9. Click Next. The Select Installation Folder dialog box opens.

7. Click Next. The Software License Agreement dialog box opens. 
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Accessing DX8100 Electronic Documentation
The DX8100 is supported by electronic and printed documentation. The printed documents come packaged with the DX8100. Table F describes 
each individual document, its distribution, and its intended use. The DX8100 server and client application also includes an online Help system. By 
default, the Help system is not enabled for viewing. 
 

Table F.  DX8100 Documentation

Document Name Location Purpose

Important Safety Instructions (C628M) Box and Disc Detailed instructions about how to safely use the DX8100

Important Security Information for System 
Administrators (C2641M)

Box and Disc Provides system administrator information for administering the 
DX8100

Quick Start Installation Guide (C2627M) Box and Disc Basic information on identifying and connecting the parts of the 
DX8100 Series DVR

Quick Start Operations Guide (C2628M) Box and Disc Basic information to help users to begin using the DX8100

Installation Manual (C2629M) Box and Disc Provides detailed instructions on installing the DX8100

Operation/Configuration for Client Application 
Software (C2631M)

Disc Detailed instructions on using the included PC, Web, and mobile 
client application software programs

Operation/Configuration for Server Application 
Software (C2630M)

Disc Detailed instructions on using the DX8100

Upgrade and Recovery Instructions (C2640M) Box and Disc Detailed instructions about upgrading the DX8100 or reinstalling 
DX8100 software

AVG Ant-Virus Installation Instructions (C3633M) Disc Detailed instructions on installing and using AVG

Symantec AntiVirus Installation Instructions (C2643M) Disc Detailed instructions on installing and using Symantec

McAfee VirusScan Installation Instructions (C2642M) Disc Detailed instructions on installing and using McAfee

Provides system administrator information for administering the DX8100

Figure 64.  Resource CD Window: Mobile Client Installation Option

2. If your system does not have a current version of Adobe® Acrobat® Reader installed, click Install Adobe Acrobat Reader and follow the 
directions.

3. Click Manuals. The documents included on the CD are displayed. 

4. Click the manual you want to view. The document is displayed in Acrobat Reader. 

To access the electronic manuals from the Resource CD: 

1. Insert the DX8100 Resource CD into your PC’s DVD drive, and then wait for the window to open.
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Appendix A: Printer Setup
This sections describes how to set up printer hardware and software.

PRINTER HARDWARE SETUP
Only printers listed on the Microsoft Windows 2000 Hardware Compatibility List and exhibiting the Designed for Microsoft Windows XP logo are 
supported by the DX8100. If installing a network printer, consult your network administrator for directions.

To print still images of recorded video from the DX8100 DVR, you must install a Windows-compatible printer using the procedure below.

Ensure that a printer has been connected to the LPT1 printer port or a USB port of the DVR or that a shared printer is available on the network.

Figure 65.  Printer Connection

To connect a printer to the DVR:

1. Shut down the DX8100. For more information about shutting down the DX8100, refer to Shutting Down on page 28 for instructions.

2. Connect the printer to the DX8100 using a standard parallel printer cable connected to the LPT1 port on the back panel of the DVR.

or

Connect the printer to the DX8100 using a standard USB cable connected to one of the four USB 2.0 ports on the back panel of the DVR.

3. Connect the printer’s power cord.

4. Restart the DX8100.

5. Set the printer’s power switch to On.
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PRINTER SOFTWARE SETUP
This section describes how to set up printer software.

WARNING:  Do not install any software that may have come with your printer on the DX8100. The DX8100’s operating system includes 
built-in services designed to communicate with printers that exhibit the Designed for Microsoft Windows XP logo.

Figure 66.  Printer Setup Window (Plug-and-Play)

SETTING UP A LOCAL PLUG-AND-PLAY PRINTER 
1. Make sure your printer is properly connected according to the instructions in the previous section.

2. Start the DX8100.

3. Wait while the system detects your printer and the Windows Add Printer Wizard begins.

4. The DX8100 client starts.

5. Log in to the DX8100 as an Administrator level user.

6. Exit the DX8100 application and return to the Windows operating system. For more information, refer to Exiting to Windows Operating 
System on page 29.

7. Click Start > Settings > Printers. The Printer Setup window opens. Double-click Add Printer. 
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Figure 68.  Local or Network Printer Dialog Box (Plug-and-Play)

9. Select the “Local printer” option button.

10. Select the “Automatically detect and install my Plug and Play printer” check box if it is not already selected.

11. Click Next and wait while the DX8100 finds and initiates your printer. 

Figure 67.  Add Printer Wizard Dialog Box (Plug-and-Play)

The Local or Network Printer dialog box opens.

8. The Add Printer Wizard dialog box opens. Click Next.
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Figure 70.  Completing the Add Printer Wizard Dialog Box (Plug-and-Play)

Figure 69.  Finding and Initializing a Plug-and-Play Printer

13. The Finish dialog box opens. Click Finish.

12. The New Printer Detection dialog box opens. Select the Yes radio button, if it is not already selected, to print a test page. Then click Next. 
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SETTING UP A LOCAL PRINTER THAT IS NOT PLUG-AND-PLAY

Figure 72.  Welcome to the Add Printer Dialog Box

Figure 71.  Printer Window (Not Plug-and-Play)

5. Welcome to the Add Printer Wizard dialog box opens. Click Next. 

To set up a local printer that is not plug-and-play:

1. Start the DX8100.

2. Log in as an Administrator level user.

3. Exit the DX8100 application and return to the Windows operating system. For more information, refer to Exiting to Windows Operating 
System on page 29.

4. Click Start > Settings > Printers. The Printer window opens. Double-click Add Printer. 
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Figure 74.  Select the Printer Port Dialog Box (Not Plug-and-Play)

8. Select the “Use the following port” radio button if it is not already selected.

9. Select LPT1.

10. Click Next. 

Figure 73.  Local or Network Printer Dialog Box (Not Plug-and-Play)

7. The Select the Printer Port dialog box opens.

6. The Local or Network Printer dialog box opens. Select the “Local printer” radio button, and then click Next. 
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Figure 76.  Name Your Printer Dialog Box (Not Plug-and-Play)

Figure 75.  Add Printer Wizard Dialog Box (Not Plug-and-Play)

12. Scroll through the list of manufacturers and select the appropriate make.

13. Scroll through the list of printers and select the appropriate model.

14. Click Next. 

15. The Name Your Printer dialog box opens. Click Next. 

11. The Add Printer Wizard dialog box opens.
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Figure 79.  Completing the Add Printer Wizard Dialog Box (Not Plug-and-Play)

Figure 78.  Print Test Page Dialog Box (Not Plug-and-Play)

18. The Completing the Add Printer Wizard dialog box opens. Click Finish.

Figure 77.  Printer Sharing Dialog Box (Not Plug-and-Play)

17. The Print Test Page dialog box opens. Select the Yes radio button, if it is not already selected, to print a test page. Then click Next. 

16. The Printer Sharing dialog box opens. Select the “Do not share this printer” radio button if it is not already selected, and then click Next. 
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SETTING UP A NETWORK PRINTER

Figure 81.  Welcome to the Add Printer Wizard Dialog Box (Network)

Figure 80.  Printer Window (Network)

5. The Welcome to the Add Printer Wizard dialog box opens. Click Next. 

Consult your network administrator for assistance on locating and setting up an available network printer.

1. Start the DX8100.

2. Log in as an Administrator level user.

3. Exit the DX8100 application and return to the Windows operating system. For more information, refer to Exiting to Windows Operating 
System on page 29.

4. Click Start > Settings > Printers. The Printer Setup window opens. Double-click Add Printer. 
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Figure 84.  Browse For Printer Dialog Box (Network)

Figure 83.  Locate Your Printer Dialog Box (Network)

8. The Browse for Printer dialog box opens.

Figure 82.  Local or Network Printer Dialog Box (Network)

7. The Locate Your Printer dialog box opens. Leave the Name text box blank and then click Next. 

6. The Local or Network Printer dialog box opens. Select the “Network printer” radio button, and then click Next. 
C2629M-C (4/08) 63



Figure 86.  Completing the Add Printer Wizard Dialog Box

Figure 85.  New Printer Detection Dialog Box (Network)

11. The Completing the Add Printer Wizard dialog box opens. Click Finish.

9. Select the desired printer from the list, and then click Next.
• Depending on your network setup, you may have to search through a hierarchical list of network resources to find the appropriate 

printer. It may be necessary to double-click objects in the list to open each branch of the resource hierarchy.
• If the printer driver software is not already installed on your DX8100, you will be prompted to download it. If prompted, click Yes to 

begin the driver download and follow any remaining instructions in the Add Printer Wizard

10. The New Printer Detection dialog box opens. Select the Yes radio button, if it is not already selected, to print a test page. Then click Next. 
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Appendix B: Connecting the Optional DX8108/DX8116-MUX Card
The DX8100 supports up to two optional DX8108-MUX or DX8116-MUX Cards. This appendix describes how to connect an analog monitor to the 
MUX Card to view real-time video on an analog monitor. The MUX card also displays real-time video on the VGA monitor. This is accomplished 
internally to the DX8100 and therefore no external connection is required. For information about installing the MUX Card in the DX8100, refer to 
the DX8100 8/16-Channel MUX Card Installation manual (C2665M). 

No configuration is required in use the MUX Card. For information about how the MUX Card displays video, refer to Working In Live View in the 
DX8100 Series Operation/Configuration Server Application Software manual (C2630M) or the server online Help.

To attach an analog monitor to the MUX Card:

1. Connect one end of a BNC coaxial cable to the analog monitor.

2. Connect the other end of the BNC cable to MUX Card BNC connector.
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Appendix C: Connecting the Dual Display Card
This appendix describes how to connect a VGA or a composite monitor to the standard Dual Display Card. The Dual Display Card allows you to 
simultaneously view up to 72 cameras with the addition of a second VGA or an additional composite monitor. 

NOTE:  The second monitor must be connected to the Dual Display Card before you start the DX8100. The DX8100 DVR is shipped from the 
factory with the Windows desktop enabled so it can be extended on to the second monitor. If the DX8100 is running before the second monitor is 
connected, the second monitor is not detected when the unit starts, the desktop is not extended to the second monitor, and video is only 
displayed on the primary monitor. If this occurs, you must manually configure Windows to display video on the extended monitor. After Windows 
recognizes the extended monitor for the first time, if the extended monitor is connected to the unit when the DX8100 restarts, the extended 
monitor configuration is maintained and you do not have to reconfigure Windows again. 

To connect a second monitor to the DX8100:

1. Do one of the following:

• VGA monitor: Connect the VGA monitor to the Dual Display Card using a VGA cable.
• Composite monitor: Connect the c composite monitor to the Dual Display Card using a BNC cable

2. To select the monitor type, do one of the following:
• Ensure that the monitor selection switch is set to the VGA position (down). 
• Ensure that the monitor selection switch is set to the analog position (up).

3. To configure Windows to recognize the second monitor, refer to the section titled Configuring the Dual Display Card in the DX8100 Series 
Operation/Configuration manual (C2630M).
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Appendix D: Connecting Audio Devices
This appendix describes how to connect audio devices to the DX8100. Before using the audio recording features of the DX8100, consult the 
applicable laws regarding audio surveillance recording for your location.

SETTING UP STANDARD AUDIO INPUTS
The DX8100 provides two standard audio line in and microphone inputs that support 2-channel (right/left) audio recording. Use a miniature phone 
plug to connect audio devices to the DX8100. For information about configuring the DX8100 to record audio, refer to the DX8100 Operation and 
Programming Server Application Software manual or online Help system.

SETTING UP OPTIONAL AUDIO CONNECTIONS
If more audio inputs are required, the DX8100 supports an 8-channel (DX8108-AUD) and 16-channel (DX8116-AUD) audio expansion option. 

Expansion audio inputs correspond to video inputs as follows:

• An 8-channel accepts up to 8 audio inputs.

• A 16-channel DVR accepts up to 16 audio inputs.

• A 24-channel DVR accepts up to 24 audio inputs.

• A 32-channel DVR accepts up to 32 audio inputs.

Audio and video inputs are configured in a one-to-one relationship. For example, audio input seven corresponds to video channel seven.

The DX8100 accepts up to 32 individual monaural audio inputs. Each input is designed to receive a line-level, analog audio signal that is sampled 
at a rate of 48 kHz (16 bits) by the DX8108-AUD’s digital analog converters (DAC). To minimize the amount of storage required to store audio data, 
the audio stream is down-sampled to 8 kHz (8 bits) for storage and playback.

Audio input is provided through an audio cable consisting of eight RCA connectors wired to a 26-pin breakout connector.

Figure 87.  Audio Connector Installation

The 26-pin connector plugs into the 26-pin Sub-D socket on the capture card. Depending on your system’s configuration, either one or two 
breakout cables will be required to connect the DVR to an audio system.

1. Connect the 26-pin audio breakout connector to the 26-pin Sub-D socket on the capture card to provide 8 or 16 individual audio inputs. Refer 
to Figure 87.

OPTIONAL AUDIO INPUTS 1-8
FOR 8 AND 16 CHANNEL DVRS.

AUDIO
(PREAMP)
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Figure 89.  Sample 16-Audio Input Cable Pinouts

Figure 88.  Sample 8-Audio Input Cable Configuration
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2. Connect each of the 8 or 16 RCA-type audio connectors to a line-level (+4 dB) gain audio source. Refer to Figure 88.

The DX8108-AUD/DX8116-AUD option accepts an unbalanced, line-level audio signal only. Line-level signaling requires a voltage between 
-1 V and +1 V into an impedance of 1 kΩ or more. This means that the output of most microphones will be too low to function when 
connected directly to the DX8100’s audio inputs. In most applications, a preamplifier such as the Louroe Electronics ASK-4® KIT #101 will 
be required to boost the signal of a microphone to a level that is acceptable for input into the DX8100.

3. Refer to the DX8100 Operation and Programming manual for information about configuring optional audio recording features.

PREAMPLIFIERSMICROPHONES PREAMPLIFIERS MICROPHONES

TO DX8100
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SETTING UP AUDIO OUTPUT
The DX8100 delivers a line-level monaural signal through a standard 0.125-inch phone jack on the rear panel of the DVR. It is recommended that 
the audio output of the DX8100 be connected to an amplifier in order to boost the output signal to a level that is sufficient to drive a speaker. 
Figure 90 illustrates an example of an audio output configuration.

Some speaker systems integrate both amplifiers and speakers in a single unit. Such a system can be connected directly to the audio output of the 
DX8100 without the need for external amplification.

Figure 90.  Sample Audio Output Configuration

To setup the audio output:

1. Connect the audio output of the DX8100 to an audio amplifier.

Use an audio cable with a 0.125-inch miniature male phone plug on one end to connect to the audio output of the DX8100. Ensure that the 
opposite end of the cable has the appropriate connectors for connection to your amplifier.

2. Connect the audio amplifier to a speaker.

AUDIO AMPLIFIER

SPEAKER

MINI MALE
PHONE PLUG
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Appendix E: Connecting an Uninterruptible Power Supply
If uninterrupted operation is desired and the power grid cannot provide adequate uptime, it is highly recommended that each DX8100 Series DVR 
be connected to a uninterruptible power supply (UPS) device (not supplied). A UPS device will supply a limited amount of battery backup power in 
the event of a power failure. Each UPS device should be configured to shut down its corresponding DVR safely during an extended period on 
battery power.

NOTE:  The UPS feature only supports Windows 2000 operating system.

Only those UPS devices that exhibit the Designed for Windows 2000 logo and are listed on the Windows 2000 Hardware Compatibility List are 
approved for use with the DX8100 Series DVR.

WARNING:  Do not install on the DX8100 any power management software that may come with your UPS device. The DX8100’s operating 
system includes built-in services designed to communicate with UPS devices that exhibit the Designed for Microsoft Windows XP logo.

The following instructions are meant as a general guide for connecting a UPS device to the DX8100 Series DVR. The example below illustrates 
the installation of an American Power Conversion UPS. This guide is not intended as a representation of how to install every possible make and 
model of UPS device. Follow the directions that came with your UPS device to ensure that the installation process is completed properly.

Figure 91.  UPS to DX8100 Connections

UPS TO DVR COMMUNICATION AND POWER CONNECTIONS
1. Shut down the DX8100. Refer to Shutting Down on page 28 for instructions.

2. Connect the UPS to the DX8100 using a standard USB cable.

3. Connect the other end of the USB cable to one of the four USB 2.0 ports on the back panel of the DVR.

4. Connect the power cord of the UPS to a standard wall socket.

5. Connect the power cord of the DX8100 to one of the power outlets on the UPS.

6. Turn the UPS device power switch on.

7. Turn the DX8100 power switch on.
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SOFTWARE SETUP FOR A USB CONNECTED UPS DEVICE

Figure 93.  Power Options Properties Dialog Box

Figure 92.  Control Panel Window with Power Options Selected

4. Double-click Power Options. The Power Options Properties dialog box opens.

5. Click the Alarms tab.

6. Adjust the Critical Battery Alarm slider to the desired power level threshold.

The slider can be adjusted to signal an alarm when UPS battery power falls below the level you select. It is suggested that you set the value 
that provides at least five minutes of power in order to shut down the DX8100 safely. Refer to the documentation supplied with your UPS to 
determine the percentage value that will provide at least five minutes of reserve power.

7. Click Alarm Action under “Critical battery alarm.” The Power Options Properties dialog box opens.

To set up a USB connected UPS device:

1. Log in as an Administrator level user if you are not already.

2. Exit the DX8100 application and return to Windows operating system (refer to Exiting to Windows Operating System on page 29).

3. Click Start > Settings > Control Panel. The Control Panel opens.
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Figure 94.  Critical Battery Alarm Actions Dialog Box

8. Select the “When the alarm goes off, the computer will: option.

9. Select Power Off from the drop-down list.

10. Click OK.

11. Click OK. The Critical Battery Alarm Actions dialog box closes.

12. (Refer to Figure 94) In the Power Options Properties Dialog Box, do the following:
a. Click Apply.

b. Click OK.
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Appendix F: Connecting a KBD300A Keyboard
This section describes how to connect the KBD300A keyboard to the DX8100 DVR. The KBD300A allows you to control DX8100 display and 
camera functions. For example, you can select cameras from the site tree, select view panes and divisions, zoom in and out, and control PTZ 
operation from the KBD300A keyboard rather than a mouse. 

Installation of the KBD300A is accomplished in two steps:

• Hardware installation, which is described in this section.

• Software configuration, which is described in the DX8100 Operations and Programming Manual.

The DX8100 supports the RS-422 data communications protocol to implement the interface with the KBD300A. For more information about 
setting up KBD300A RS-422 communications settings, refer to Operation and Programming Manual.

Figure 95.  KBD300A Connected to the DX8100

Figure 95 illustrates how the KBD300A is connected to the DX8100 server.

The table below describes parts of the KBD300A and DX8100 installation.

Table G.  Parts of the DX8100 and KBD300A Installation 

Part Description

RJ-45 The DX8100 provides four RJ-45 ports identified as Port 1–Port 4, with Port 1 being on the bottom.

Data cable A user-supplied cable that connects the RJ-45 wall block to the DX8100. 

Wall block A surface mount box that does the following:

KBD300A Keyboard.

Keyboard data 
cable

A 25-foot keyboard data and power cable for the KBD300A. The KBD300A uses this cable to connect to the wall 
block.

Wall transformer A 12 VAC transformer that powers the KBD300A. 

DX8100 DX8100 server.

Item
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• Implements data connectivity between the DX8100 and KBD300A.

• Implements power connectivity between the 12 VAC transformer and KBD300A.
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REQUIRED ITEMS
You must have the following items to connect the KBD300A to the DX8100 DVR:

• KBD300A keyboard with firmware release version 5.0 or greater: For more information about the KBD300A, refer to the Installation/
Operation KBD300A Universal Keyboard manual.

• KBDKIT series remote wiring kit: For more information about the KBDKIT, refer to KBDKIT Series Remote Keyboard Wiring Kit.

• User-supplied Category 5 straight-through RJ-45 data cable.

INSTALLING KBD300A HARDWARE
This section describes how to install the KBD300A hardware and connect the KBD300A to the DX8100 server. 

You must set up the KBDKIT first. Figure 96 illustrates how to wire the user-supplied data cable and connect the 12 VAC transform to the wall 
block. Refer to the Parts List for information about the items required to connect the KBD300A to the DX8100. The only item not included in the 
KBDKIT is the data cable. The KBDKIT Series Remote Keyboard Wiring Kit manual is included in the kit.

Description

RJ-45 wall block
RJ-45 plug
Data cable

The user-supplied Cat5 data cable with the attached RJ-45 plug connects the wall block to the DX8100. Refer to Table H for the pinout 
designations.

Table H.  Pinout Designations

Pin Signal Pin Signal
1 TX+ 5 Ground
2 TX- 6 NC
3 12 VAC 7 RX-
4 12 VAC 8 RX+

Figure 96.  KBDKIT Wall Block and RJ-45 Cable Wiring

To set up the KBDKIT and install the KBD300A keyboard:

1. Remove the wall block cover.

2. Wire the 12 VAC transformer to the wall block.

3. Construct an RJ-45 Cat5 straight-through cable with no connector on one end that is wired to the correct pin-out of the RJ-45 port on the 
wall block.
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7
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Qty
1 Wall transformer
1
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Figure 97.  Connecting the KBD300A to the DX8100

4. Connect the RJ-45 data cable from the wall block to a DX8100 RS-422 port (ports 1-4).

SELECTING THE KBD300A OPERATIONAL MODE

You use the KBD300A’s DIP switch to set the keyboard’s address and select the operational mode. 

• Only one KBD300A is attached to the DX8100 at any one time.

• The DX8100 only supports the KBD300A CM6700 mode. 

DIP switch positions 1 through 4 are used to set the keyboard’s address. Switch position 5–8 are used to select the operational mode. 

Figure 98.  Setting the KBD300A DIP Switch

To set the KBD300A to operate in the CM6700 mode:

1. On the back of the KBD300A, remove the two screws and the DIP switch cover.

2. Set the DIP switch settings as shown in Table I on page 75. In this case, the address is 3 and the operational mode is C6700 ASCII. This 
mode is only supported in firmware version 5.0 and later.

Table I.  DIP Switch Settings

Switch 1 2 3 4 5 6 7 8
UP = OFF OFF OFF OFF OFF OFF
DOWN = ON ON ON ON

For more information about setting the address and selecting the operational mode, refer to the KBD300A Installation/Operation Manual 
(C527M).

3. Replace the DIP switch cover plate.

This concludes the hardware installation phase. Next, you must configure the DX8100 data communications setting for the KBD300A. For more 
information about setting the DX8100 data communications setting for the KBD300A, refer to the DX8100 Operation/Configuration manual 
(C2630M) or DX8100 Help.
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Appendix G: Connecting ATM/POS Devices
The DX8100 allows you to connect up to 16 ATM/POS devices and provides two ATM/POS device modes: single mode and multimode. The single 
device mode supports up to four ATM/POS devices; multimode supports up to 16 ATM/POS devices. Single mode and multimode can be 
combined, but the DX8100 only supports a total of 16 ATM/POS connections.

SINGLE MODE ATM/POS DEVICE CONNECTIVITY
The DX8100 supports connection to ATM/POS equipment in the single mode using the AVE VSI-Pro. The VSI-Pro is designed to interface with 
many different types of cash registers and POS equipment and allows you to program the VSI-Pro to match your register’s communications 
settings. The VSI-Pro handles the data communication between the ATM/POS device and DX8100, providing a standard compatible  
RS-422/RS-485 and RS-232 interface to the DX8100. 

For information about the VSI Pro and the various types of ATM/POS equipment that it supports, contact AVE:

• Technical Support department at http://www.americanvideoequipment.com/technical_support/index.html.

• Customer Service department at http://www.americanvideoequipment.com/customer_service/index.html.

Installation of ATM/POS devices and the VSI-Pro is accomplished in two steps:

• Hardware installation: 
– Connect the VSI-Pro to the ATM/POS device. For information about connecting your VSI-Pro to the ATM/POS device, refer to the 

VSI-PRO Operation Manual and the documentation that came with your ATM/POS device.
– Connect the VSI-Pro to the DX8100. For information about connecting the VSI-Pro the DX8100, refer to Configuring DX8100 ATM/POS 

Communication Options on page 84.

• Software configuration: 
– Program the VSI-Pro to communicate with your ATM/POS device. For information about programming the VSI-Pro, refer to the VSI-PRO 

Operation Manual.
– Set up the DX8100 to interface with the VSI-Pro. For information about setting up the DX8100 to communicate with the VSI-Pro, refer 

to the DX8100 Server Operation/Configuration manual (C2630M) or DX8100 application Help.

ATM/POS CONFIGURATIONS

Table J summarizes the supported ATM/POS configurations and the items required to implement the configuration. 

Table J.  ATM/POS Configurations

Connection Type Required Items

RS-232 (COM 1/COM 2) The DX8100 supports interfacing ATM/POS devices using one of both of the RS-232 COM ports via a DB9 
connector. 

The following items are required:

RS-422 (Ports 1 to 4) The DX8100 supports interfacing ATM/POS devices using the RS-422 communications ports  
(ports 1 to 4) through a RJ-45 connector. 

Up to four each of the following items are required:

For more information about the PV140 RS-232/422 Converter Kit, refer to PV140 RS-232/422 Converter Kit 
Installation manual.

• One AVE VSI-PRO Version 12.00 or higher device for each ATM/POS device.

• One AVE triport cable for each ATM/POS device. The cable is required for connecting the ATM/POS 
device to the VSI-PRO and to connect the VSI-PRO to the DX8100 RS-232 COM 1 or COM 2 port.

• AVE VSI-PRO Version 12.00 or higher device for each ATM/POS device.

• AVE triport cable for each ATM/POS device. The cable is required for connecting the ATM/POS device to 
the VSI-PRO and to connect the VSI-PRO to the PV140 RS-232/422 Converter Kit.

• PV140 RS-232/422 Converter Kit.

• User-supplied Category 5 straight-through RJ-45 data cable. This cable is required to connect the PV140 
RS-232/422 Converter Kit to the DX8100 RS-422 RJ-45 port.
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CONNECTING ATM/POS HARDWARE

This section describes how to connect ATM/POS devices to the DX8100 server using the VSI-PRO. Direct connection between an ATM/POS 
device and the DX8100 without using the VSI-PRO is not supported. http://www.americanvideoequipment.com/compatibility.html

Go to http://www.americanvideoequipment.com/compatibility.html to verify that your ATM/POS device is listed in the VSI Compatibility table.

Using the VSI-PRO Triport Cable

Figure 99.  VSI-PRO DB9-to-DB9 Triport Cable

Figure 99 illustrates the VSI-PRO Dresser Wayne DB9-to-DB9 Triport cable used to connect between the ATM/POS, VSI-PRO, and DX8100 server. 
For specific details regarding ATM/POS device cabling requirements, refer to the VSI-PRO operations manual.

�
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Table K describes the VSI-PRO DB9-to-DB9 triport cable.

Table K.  VSI-PRO DB9-to-DB9 Triport Cable 

Part Description

DB9 (male) DB9 male connector that interfaces with the VSI-PRO. The VSI-PRO reroutes signals to the DX8100 
according to the following pin assignments: 

VSI-PRO

DX8100

DB9 (male) DB9 male connector that connects the VSI-PRO to the DX8100. The pin assignments are as follows:

Cable The cable length is 3 feet (0.91 m).

DB9 (female) DB9 female connector that connects the ATM/POS device to the VSI-PRO. 

Item

ì

• Pin 3: TD

• Pin 7: TRS

• Pin 2: RD

• Pin 5: SGND

î
• Pin 2: RD

• Pin 5: SGND
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Setting Up a RS-232 ATM/POS Device Configuration

This section describes how to set up a RS-232 ATM/POS device configuration. Use the RS-232 ATM/POS device configuration to record 
searchable ATM/POS data that is synchronized with recorded video. In this configuration, the camera is connected directly to the DX8100 camera 
input. The ATM/POS data is routed through the VSI-PRO to the DX8100 RS-232 communications port. ATM/POS output is recorded by the DX8100 
as data. Once recorded, the ATM/POS data is searchable and can be displayed synchronously with the recorded transaction video. 

Figure 100.  RS-232 ATM/POS Device Configuration

Figure 100 illustrates a RS-232 ATM/POS device configuration. One or two ATM/POS devices can be connected to the DX8100. One camera is 
shown, but multiple cameras can be assigned to monitor the ATM/POS event from different physical positions. For specific details about the 
DX8100 back panel, refer to Figure 11 on page 23.
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Table L describes the items required for the RS-232 ATM/POS device configuration.

Table L.  Single RS-232 ATM/POS Device Configuration 

Part Description

Camera The designated camera positioned to monitor the ATM/POS event. One or more cameras can be configured to 
respond to an ATM/POS event.

Video cable A user-supplied cable that connects the camera to the DX8100 video input.

VSI-PRO AVE VSI-PRO ATM/POS interface.

Data cable AVE triport cable used to connect the ATM/POS device to the VSI-PRO and the VSI-PRO to the DX8100 RS-232 
COM1 or COM2 port.

DX8100 server The DX8100 DVR.

ATM/POS device The ATM/POS device.

Item
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Figure 101.  RS-422 ATM/POS Device Configuration

Figure 101 illustrates a dual ATM/POS device configuration. 
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Table M describes the items required for the RS-422 ATM/POS device configuration.

Table M.  Dual RS-422 ATM/POS Device Configuration 

Part Description

Camera The designated cameras positioned to monitor the ATM/POS event. One or more cameras can be configured 
to respond to an ATM/POS event.

Video cable A user-supplied video cable that connects the cameras to the DX8100 video input.

Data cable AVE triport cable used to connect the ATM/POS device to the VSI-PRO and to connect the VSI-PRO to the 
DX8100 RS-232 COM1 or COM2 port. 

VSI-PRO AVE VSI-PRO ATM/POS interface.

ATM/POS device The ATM/POS device.

DX8100 server The DX8100 DVR.

To connect the ATM/POS device and VSI-PRO in a RS-232 ATM/POS configuration:

1. Use the appropriate AVE cable to connect the VSI-PRO to the ATM/POS device. For information about connecting the VSI-PRO and  
ATM/POS device, refer to the ATM/POS Installation and VSI-PRO VSI-PRO Version 12.00 Operation manuals. 

2. Connect the AVE RS-232 cable to the DX8100 COM1 or COM2 port.

3. Connect the VSI-PRO power transformer into the VSI-PRO.

4. Plug the VSI-PRO power transformer into an appropriate AC power source.

Item
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Setting Up a RS-422 ATM/POS Device Configuration

This section describes how to set up a RS-422 ATM/POS device configuration. This configuration is used for applications that have one to four 
ATM/POS devices. Use the RS-422 ATM/POS device configuration to record searchable ATM/POS data that is synchronized to recorded 
transaction video. You can configure multiple cameras to be associated with a transaction event. 

In this configuration, the camera is connected directly to the DX8100 camera input. The ATM/POS data from each ATM/POS device is routed 
through its respective VSI-PRO to a DX8100 RS-422 port. ATM/POS output is recorded by the DX8100 as data. Once recorded, the ATM/POS data 
is searchable and can be displayed with the transaction video. 

The interface connection for this configuration is summarized as follows:

• Each respective camera is connected directly to the DX8100 camera input.

• Each ATM/POS device is connected as follows:
– Each ATM/POS device is connected to a separate VSI-PRO.
– Each VSI-PRO device is connected to a PV140 RS-232/422 converter.
– Each PV140 is connected to a DX8100 RS-422 port through a user-provided RJ-45 cable. 

ATM/POS output is recorded by the DX8100 as data. Once recorded, the ATM/POS data is searchable and can be displayed with the transaction 
video. 
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Figure 102.  Multiple ATM/POS Device Configuration

Figure 102 illustrates a multiple RS-422 ATM/POS device configuration. 
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Table N describes the items required for the multiple ATM/POS device configuration.

Table N.  Multiple ATM/POS Device Configuration 

Part Description

Camera The designated cameras positioned to monitor the ATM/POS event. One or more cameras can be configured 
to respond to an ATM/POS event.

Video cable A user-supplied cable that connects the cameras to the DX8100 video input.

VSI-PRO AVE VSI-PRO ATM/POS interface.

Triport cable AVE triport cable used to connect the ATM/POS device to the VSI-PRO and the VSI-PRO to the PV140.

DX8100 server The DX8100 DVR.

ATM/POS device The ATM/POS device.

PV140 A RS-232 to RS-422 converter that provides a bidirectional electrical interface between RS-232 and RS-422 
data ports. 

Data cable User-supplied RJ-45 cable that connects the PV140 to Port 1 to 4 of the DX8100 DVR. The cable is 
constructed with a 2-wire pigtail on one end and an RJ-45 plug on the other. For information about the  
RJ-45 plug wiring, refer to Figure 11 on page 23. 
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PV140-to-RS-422 Connection

Figure 103.  PV140 RS-232 to RS-422/485 Converter

Figure 103 illustrates the cabling requirements to implement PV140 to RS-422 connectivity to the DX8100 RJ-45 port. 
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Table O describes the PV140 RS-232 to RS-422 converter. 

Table O.  VSI-PRO DB9-to-DB9 Triport Cable 

Part Description

DB9 (female) PV140 DB9 female connector that interfaces with the triport DB9 male connector. The VSI-PRO triport DB9 
male connector pin assignments and the PV140 terminal wiring pin assignments are described in Table P on 
page 82.

Power supply PV140 power transformer provides 12 VDC.

Transmit data PV140 terminal TX+, which connects to the pin 8 (RX+) of the DX8100 RJ-45 connector. For information 
about the DX8100 back panel, refer to Figure 11 on page 23.

Transmit data PV140 terminal TX-, which connects to the pin 7 (RX-) of the DX8100 RJ-45 connector. For information about 
the DX8100 back panel, refer to Figure 11 on page 23.

RJ-45 User-supplied RJ-45 connector that interfaces the ATM/POS device to DX8100 ports 1 to 4.

Table P.  PV140 DB9 Pinouts

Triport DB9 Male User-Supplied RJ-45 Cable

Pin 2: RD Pin 2: RD

Pin 5: SGND Pin 5: SGND

Connecting ATM/POS Devices using RS-422

To connect ATM/POS devices in a RS-422 configuration, refer to Figure 103 and Table O on page 82 and do the following:

1. Use the appropriate AVE cable to connect each additional VSI-PRO to an ATM/POS device. 

2. Set up one PV140 RS-232 to RS-422 converter and user-supplied RJ-45 cable for each ATM/POS device. For installation instructions, refer 
to the PV140 RS-232/422 Converter Kit Installation manual (C1919M).

3. Insert the RJ-45 plug into ports 1 to 4 as required.

Item
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MULTIMODE ATM/POS DEVICE CONNECTIVITY

Figure 104.  Sample ATM/POS Device Connectivity in Multimode

Using the DX8100 ATM/POS device multimode, you can connect up to 16 ATM/POS devices to the DX8100. One AVE Regcom RS-485 Network 
System Slave box is required for each ATM/POS device you want to connect. One Hydra RS-485 Network System Master unit is required to 
provide the interface between the ATM/POS devices and the DX8100.

16 REG COM1 REG COM

ATM/POS (16)ATM/POS (1)

HYDRA

DX8100 SERVER

The Regcom box receives transaction data from the ATM/POS device and stores the data before sending it to the Hydra control unit. The Hydra 
control unit allows the connection of multiple ATM/POS devices to Regcom boxes. The Regcom units are connected in serial using an RJ-45 
cable. The last Regcom in the series connects to the Hydra unit, which then connects to the DX8100 using a standard RS-232C connection. 

REGCOM AND HYDRA HARDWARE INSTALLATION

This section provides general installation instructions for connecting and configuring the Regcom units and Hydra box to interface the ATM/POS 
devices to the DX8100. For specific information about how to setup a Regcom box, refer to the Regcom RS-485 Network System operation 
manual. For specific information about how to setup a Hydra box, refer to the Hydra RS-485 Network System operation manual.

1. Establish a numbering plan (1 to 16) for each POS group consisting of an ATM/POS device, Regcom box, and the assigned camera. 

2. Configure a Regcom box for each ATM/POS group. 

3. Connect each ATM/POS device to its respective Regcom unit.

4. Interconnect the Regcom boxes: ATM/POS Regcom box 1 connects to ATM/POS 2 Regcom box 2, and so forth.

5. Configure the Hydra box and connect the last Regcom unit to the Hydra box.

6. Connect each camera assigned to record ATM/POS activity to the DX8100. 

7. Set up the DX8100 port/device communications settings. For information about setting up the ATM/POS device communication setting, 
refer to Configuring DX8100 ATM/POS Communication Options on page 84, the DX8100 Server Operation/Configuration manual (C2630M) 
or DX8100 application Help.
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CONFIGURING DX8100 ATM/POS COMMUNICATION OPTIONS
Once you have installed the ATM/POS device(s), you must configure the DX8100 to communicate with the ATM/POS device(s). This section 
describes how to set up DX8100 ATM/POS options for single mode or multimode applications. For more information about configuring DX8100 
ATM/POS options, refer to the DX8100 Operations/Configuration manual (C2630M) or the DX8100 server online Help.

Figure 105.  Multimode Communication Port Settings

To configure the DX8100 to communicate with the ATM/POS device(s): 

1. On the DX8100 toolbar, click . The Setup dialog opens to the Camera page.

2. In the Setup dialog box, click . The Network page is displayed.

3. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

4. Do one of the following:
• Single mode: In the Communication Port drop-down box, select a port (COM1 or Port 1 to Port 4).
• Multimode: In the Communication Port drop-down box, select COM1. 

If you select COM1, the Interface Mode option is unavailable (the default setting is RS-232C for COM1).

5. In the device drop-down box, select ATM/POS, and then configure the following port settings.
• Interface mode (the default setting is RS-232C for COM1)
• Baud rate
• Parity
• Data bits
• Stop bits
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Figure 107.  Data Format List Page

Figure 106.  Device Configuration Page

7. In the Device Configuration page, do the following:
a. Click Data Format. The Data Format List page is displayed. By default, the ER-650 data format is displayed. You can modify the ER-650 

data format or create a new one.

6. In the Port/Device page, do the following:
a. In the Communication Port Configuration section, click Configure. The Device Configuration dialog box opens.

b. In the Device Mode drop-down box, select one of the following options:

• Single Mode (this is the default mode)

• Multi Mode
C2629M-C (4/08) 85



Figure 108.  Modified ER-650 Data Format Dialog Box

9. Using the information from the transaction record or other source, set the parameters for the following Data Format sections (as 
applicable):
• Transaction Format
• Monetary Format
• Time Format
• Character Format

b. To create a data format, do one of the following:

• To use and modify the ER-650 format, highlight the data format, and then click Edit.

• To start a new data format, click Add. 

The Data Format dialog box opens.

8. In the Data Format Name text box, type a name.
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Figure 109.  Data Format List

11. In the Device Configuration page, do the following for ATM/POS device:
a. Click the Settings tab. The Available ATM/POS Device table is displayed.

b. In the Device ID column, click an ATM/POS device to select it.

c. Double-click the Data Format cell for the selected ATM/POS device. The Data Format cell drop-down box is displayed.

d. Click in the Data Format cell to display the available data formats.

e. Select the data format you want to assign to the ATM/POS device.

12. In the Protocol column, do the following:
a. Double-click the Protocol cell for the selected ATM/POS device. The Protocol cell drop-down box is displayed.

b. Click in the Protocol cell to display the available protocols.

c. Select the protocol you want to assign to the ATM/POS device.

10. Click OK. The Data Format page redisplays and the newly created data format is listed in the Data Format List.
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Figure 110.  Assigning the Data Format ATM/POS Devices

14. Click Link . The Linking setup page is displayed.

13. Do one of the following:
• Click Apply to confirm selection and remain in the Device Configuration dialog box.
• Click OK to confirm selection and return to the Port/Device page.
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Figure 111.  Event-Recording Link Settings Page

16. In the ATM/POS Record Link Settings area, do the following:
a. In the ATM/POS Address drop-down box, select an ATM/POS01 address to switch the address set for the associated Regcom box.

b. In the Enable Record/Live on Source ATM/POS Event area, click a camera to link the camera to the ATM/POS address.

c. Click Apply.

17. Click Schedule . The Schedule setup page is displayed.

15. Click Event-Recording Link Settings. The Event-Recording Link Settings page is displayed.
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Figure 113.  ATM/POS Data Transaction Recording

Figure 112.  Schedule Setup Page

19. On the DX8100 toolbar, click Setup . The DX8100 live view mode is displayed.

20. Drag the camera linked to an ATM/POS address to a view pane.

21. From the DX8100 menu bar, click View > OSD > POS. The ATM/POS transaction data is displayed in the view pane for the camera linked to 
the ATM/POS address.

18. Create an ATM/POS schedule for the camera you linked to the ATM/POS address.
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Specifications

ELECTRICAL/VIDEO
Input Voltage 100-240 VAC +10%, 50/60 Hz, autoranging*

Power Consumption Maximum 350 W

Signal System NTSC/PAL

Operating System Windows XP Embedded only

Recording Resolutions NTSC PAL 
320 x 240 320 x 288 
640 x 240 640 x 288 
640 x 480 640 x 576 
352 x 240 352 x 288 
704 x 240 704 x 288 
704 x 480 704 x 576

Compression Pelco proprietary

Video Inputs 8/16/24/32 (looping with automatic termination)

VGA Outputs 1 

Analog Video Outputs 1 with DX8108 and DX8116 
2 with DX8124 and DX8132

Alarm Input Terminals 8/16/24/32 (user-selectable, N.O./N.C.)

Relay Output Terminals 8/16/24 (user-selectable, N.O./N.C.)

Relay Contact Ratings†

Rated (Resistive) Load 0.5 A at 120 VAC or 1 A at 24 VDC

Remote Administration Full remote control through a TCP/IP network

Total Recording Rate Up to 480 ips at CIF 
Up to 240 ips at 2CIF 
Up to 120 ips at 4CIF

MECHANICAL
Connectors

BNC: Video inputs and outputs
6-Pin Mini-DIN: PS/2 mouse and keyboard (not supplied)
DB9: COM 1
DB15: VGA port
DB26: Optional audio option
RJ-45: 10/100/1000 megabit Ethernet port and RS-485/RS-422 ports
Audio Connectors: 3 miniature phone jacks: line in, microphone in, and audio out
USB: 6 high-speed USB 2.0 ports (2 in front, 4 in rear); connect mouse and keyboard

Optional Audio Connectors
Audio Decoding GSM610 Wave Format
Audio Bit Rate 8 Kbps
Audio Levels

Input Line-level input
Output Line-level output

Audio Connectors Female RCA jacks
Audio Inputs Eight for 8-channel and sixteen for 16-channel unit
Audio Outputs 1

ENVIRONMENTAL
Operating Temperature 50° to 95°F (10° to 35°C)

Relative Humidity Maximum 80%, noncondensing
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GENERAL
Dimensions

Desktop 19.9" D x 17.0" W x 7.0" H  
(50.55 x 43.18 x 17.78 cm)

Rack Mount 22.0" D x 19.0" W x 7.0" H  
(55.88 x 48.26 x 17.78 cm)

Unit Weight 47 lb (21 kg) maximum (fully equipped, 32-channel)

Shipping Weight 68 lb (31 kg) maximum (fully equipped, 32-channel)

 *It is recommended that an UPS device be used with the DX8100 with a 700 VA or better rating. 
  †Relays are grounded.

(Design and product specifications subject to change without notice.)
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PRODUCT WARRANTY AND RETURN INFORMATION

WARRANTY
Pelco will repair or replace, without charge, any merchandise proved defective in 
material or workmanship for a period of one year after the date of shipment. 

Exceptions to this warranty are as noted below:

• Five years on fiber optic products and TW3000 Series unshielded twisted pair 
(UTP) transmission products.

• Three years on Spectra® IV products.
• Three years on Genex® Series products (multiplexers, server, and keyboard).
• Three years on DX Series digital video recorders, DVR5100 Series digital video 

recorders, DigitalSENTRY® Series hardware products, DVX Series digital video 
recorders, NVR300 Series network video recorders, and Endura® Series 
distributed network-based video products.

• Three years on Camclosure® and Pelco-branded fixed camera models, except 
the CC3701H-2, CC3701H-2X, CC3751H-2, CC3651H-2X, MC3651H-2, and 
MC3651H-2X camera models, which have a five-year warranty.

• Three years on PMCL200/300/400 Series LCD monitors.
• Two years on standard motorized or fixed focal length lenses.
• Two years on Legacy®, CM6700/CM6800/CM9700 Series matrix, and DF5/DF8 

Series fixed dome products.
• Two years on Spectra III™, Spectra Mini, Esprit®, ExSite®, and PS20 scanners, 

including when used in continuous motion applications.
• Two years on Esprit and WW5700 Series window wiper (excluding wiper 

blades).
• Two years (except lamp and color wheel) on Digital Light Processing (DLP®) 

displays. The lamp and color wheel will be covered for a period of 90 days. The 
air filter is not covered under warranty.

• Two years on Intelli-M® eIDC controllers.
• One year (except video heads) on video cassette recorders (VCRs). Video heads 

will be covered for a period of six months.
• Six months on all pan and tilts, scanners, or preset lenses used in continuous 

motion applications (preset scan, tour, and auto scan modes).
Pelco will warrant all replacement parts and repairs for 90 days from the date of 
Pelco shipment. All goods requiring warranty repair shall be sent freight prepaid 
to a Pelco designated location. Repairs made necessary by reason of misuse, 
alteration, normal wear, or accident are not covered under this warranty.

Pelco assumes no risk and shall be subject to no liability for damages or loss 
resulting from the specific use or application made of the Products. Pelco’s liability 
for any claim, whether based on breach of contract, negligence, infringement of 
any rights of any party or product liability, relating to the Products shall not exceed 
the price paid by the Dealer to Pelco for such Products. In no event will Pelco be 
liable for any special, incidental, or consequential damages (including loss of use, 
loss of profit, and claims of third parties) however caused, whether by the 
negligence of Pelco or otherwise.

The above warranty provides the Dealer with specific legal rights. The Dealer may 
also have additional rights, which are subject to variation from state to state.

If a warranty repair is required, the Dealer must contact Pelco at (800) 289-9100 or 
(559) 292-1981 to obtain a Repair Authorization number (RA), and provide the 
following information:

1. Model and serial number 
2. Date of shipment, P.O. number, sales order number, or Pelco invoice number 
3. Details of the defect or problem

If there is a dispute regarding the warranty of a product that does not fall under 
the warranty conditions stated above, please include a written explanation with 
the product when returned.

Method of return shipment shall be the same or equal to the method by which the 
item was received by Pelco.

RETURNS
To expedite parts returned for repair or credit, please call Pelco at (800) 289-9100 
or (559) 292-1981 to obtain an authorization number (CA number if returned for 
credit, and RA number if returned for repair) and designated return location.

All merchandise returned for credit may be subject to a 20 percent restocking and 
refurbishing charge.

Goods returned for repair or credit should be clearly identified with the assigned 
CA or RA number and freight should be prepaid. 

The materials used in the manufacture of this document and its components are compliant to the requirements of Directive 2002/95/EC.

This equipment contains electrical or electronic components that must be recycled properly to comply with Directive 2002/96/EC of the European Union 
regarding the disposal of waste electrical and electronic equipment (WEEE). Contact your local dealer for procedures for recycling this equipment.
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REVISION HISTORY

Manual # Date Comments
C2629M 9/06 Original version.
C2629M-A 6/07 Added video quality statement, new features, optional MUX card and audio connection, and updated client software and DX9200HDDI installation procedures.
C2629M-B 4/08 Corrected information and documented new features for the Dual Display Card and expanded ATM/POS devices. Also updated the external expansion section.
C2629M-C 4/08 Corrected instructions about selecting the monitor type when the monitor selection switch is set to the analog position.

Pelco, the Pelco logo, Camclosure, Coaxitron, Integral Digital Sentry, Endura, Esprit, ExSite, Genex, Intelli-M, Legacy, and Spectra are registered trademarks of Pelco, Inc. © Copyright 2008, Pelco, Inc. All rights reserved.
Spectra III is a trademark of Pelco, Inc.
DLP is a registered trademark of Texas Instruments Incorporated.
Microsoft, Windows, Internet Explorer, DirectX, ActiveSync, and ActiveX are registered trademarks of Microsoft Corporation. 
Intel, Pentium, and XScale are registered trademarks of Intel Corporation.
Netscape Navigator is a registered trademark of the Netscape Communications Corporation.
StorageWorks is a registered trademark of Compaq Information Technologies Group.
ASK-4 is a registered trademark of Louroe Electronics.
Adobe and Acrobat are registered trademarks of Adobe Systems Incorporated.
Nero is a registered trademark of Nero AG.
McAfee and VirusScan are registered trademarks of McAfee, Inc.
AVE is a trademark of American Video Equipment.
Symantec and Symantec AntiVirus are trademarks or registered trademarks of Symantec Corporation.



Worldwide Headquarters
3500 Pelco Way

Clovis, California 93612 USA

USA & Canada
Tel: 800/289-9100
Fax: 800/289-9150

International
Tel: 1-559/292-1981
Fax: 1-559/348-1120

www.pelco.com

ISO9001

Australia  |  Finland  |  France  |  Germany  |  Italy  |  Macau  |  The Netherlands  |  Russia  |  Singapore

South Africa  |  Spain  |  Sweden  |  United Arab Emirates  |  United Kingdom  |  United States


